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This manual and the software described in it may be used within your academic depart-
ment or medical group setting, provided you inform users of these conditions of use.
Otobase has been extensively tested, but because of many recent coding additions it may 
have undiscovered software bugs. We cannot be liable for any defects in the program. We 
plan to add additional features and change the software in response to user feedback. We 
will provide users who request it with an upgrade pathway and guarantee that any data 
collected with the present version will be compatible with future versions.
Otobase software performance reports should be sent to: 
Marc D. Coltrera, M.D.
University of Washington
Department of Otolaryngology-Head and Neck Surgery
Box 356515, Seattle, WA 98l95. (206) 221-2430 (206) 543-5152 FAX 
Email: otobase@u.washington.edu
Web site: http://depts.washington.edu/otobase

This manual was written in cooperation with the University of Washington Department 
of Technical Communication.
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The Otobase method of data sharing
Sharing data in multi-center clinical studies presents a number of obstacles. Some are physi-
cal, such as collating the data, verifying that participants are filling in data completely, and 
checking for protocol violations. Some are more psychological, but no less important, such as 
allowing control of the data by the participants as opposed to a central collating authority.

Otobase has been designed to address these issues directly. Developed primarily as a research 
tool, this software supports multi-site trials with features that allow consistent data collection 
while preserving study subject confidentiality and data traceability.

Some of these features include:

•  Public/private key encryption, giving study participants the confidence that shared 
data can be viewed only by someone they wish to view it, and allowing a central site to 
store backup copies of encrypted data sent by study participants as a hedge against data 
loss.

•  Checksums, which detect the slightest change in transmitted data and make it virtually 
tamper-proof. Shared data exports can be limited to a few data fields during the initial 
phase of a study while documents containing only checksum information verify that a 
larger data set is actually being collected. Participants can later share the larger data set 
with the assurance of its integrity.

Part 1

How this manual is organized
The Otobase clinical trials manual is divided into three parts.
If you wish, you can skip directly to Part 3 on Page 18, which gives step-by-step instructions for 
setting up a trial using the program’s automated features. You will find separate sections for 
study coordinators and participants so that you only need to follow the specific directions for your 
given role in a trial. Those who would like an overview of the program’s features and how they 
work together should read Part 1 first. If you would like to learn how to manually export and 
encrypt data in the special Otobase TRANSFER format, as well as manually decrypt and import 
the TRANSFER documents, you will find instructions in Part 2 starting on Page 8.
For a more comprehensive explanation of the full capabilities of the software to enter, retrieve 
and report data, as well as a reference to all menus, commands and data fields, please refer to 
the Otobase User Guide.
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•  Study participant IDs, allowing data to be merged from multiple sites without demo-
graphic identifiers, preserving subject anonymity while maintaining identification of 
data sources.

Otobase is also designed to help coordinate study activities, with data entry Checklists that 
ensure saved records meet study criteria, and modifiable staging, protocol and approved pro-
cedure lists that aid in consistent reporting. All of these features can be updated by a study 
coordinator and distributed to participants as computer files, by e-mail, or as downloads from 
the Web.

Setting up a trial using the automated features built into Otobase involves these main steps:

• Creating matching Clinical Group records for the study group.
• Assigning unique Study Participant IDs.
• Setting up data encryption and decryption.
• Defining study data to be exported.

Part 1 will present an overview of each of these steps, as well as explain the unique Otobase 
Checksum mechanism.

Creating matching database records for the study group
Most of the important tools used to organize, share and protect data gathered in a trial are 
centered around the Clinical Group record.

A Clinical Group can be an institution, such as a hospital, or it can simply be a study. For 
example, a Clinical Group in Otobase could be a grouping of subjects who share something 
in common that researchers wish to study, such as the use of cis-platinum/5FU/ radiation to 
treat tumors or involvement in a p53 gene therapy trial.

When initiating a study, it is critically important that a study coordinator decide on a unique 
List Name for the group. In addition to identifying a Clinical Group, the List Name is used to 
automate encryption and e-mail exporting/importing features. To avoid conflicts with the 

Clinical Groups that may already exist in a study participant’s data file, the study’s List Name 
needs to be unique. One of the best ways to ensure this is to create a name with a prefix, such 
as UW02_, which could stand for the initials of the study coordinator’s institution and the 
year the study began (see List Name in picture above). It is also a good idea to use the same 
prefix in naming searches, exports and Checklists that are associated with the study to make 
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sure these will also be uniquely named and won’t conflict with other such items in a partici-
pant’s data file.

The best way to ensure that key information in the Clinical Group record is the same for all 
involved in a study is for the coordinator to create the initial record, then send the informa-
tion to all participants so they can create a matching record.

For an explanation of how to set up the Clinical Group record, see Page 21.

Assigning unique Study Participant IDs
Otobase automatically generates an internal identification number each time a new record is 
created. These make it possible to mix data from multiple sites in a single database being used 
in a study. The Participant ID number and the related Study Participant ID are an integral 
part of this capability.

The first time you use the Otobase structure file with a 
newly created data file, you are asked to enter a Participant 
ID number between 0 and 999. Otobase uses this number 
as part of the internal ID numbers to identify and relate 
records in different tables.

For example, all subject-related records have a unique 
number in the Subject_ID field. Otobase uses the Participant ID as the last three digits of this 
subject identifier.

Because there is no way to guarantee that participants in a multi-
site trial implemented their Otobase data files with unique Partic-
ipant IDs, the study coordinator can assign Study Participant ID 
numbers that will be substituted for the last three digits of IDs in records exported for a trial. 
This is an automated function that is only available for data exports encrypted with a private 
key. The site coordinating a study will be able to decrypt the data and import it only if the 
Study Participant ID number and the associated public decryption key agree. This guarantees 
that only the participant authorized to use that Study Participant ID has submitted the data. 
For instructions on assigning these IDs, see Page 22.

Using encryption to protect shared data
Otobase’s use of public/private key encryption allows participants in a geographically diverse 
study to share information over the Internet or via disk while protecting both the privacy of 
study subjects and the integrity of data.

Public/private key encryption, in which the encryption and decryption keys form a unique 
pair, is a powerful tool for proving the source of a message or data. The person sending data 
generates both a private and a public key, then encrypts the data with the private key and 
sends the encrypted data to the receiver. By a separate method, the sender needs to convey 
the public key to the receiver for use in decrypting the data. The receiver then uses the public 
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key and can read the decrypted data only if the proper private key was used to encrypt it. 
Thus the receiver knows for certain that the originator sent the data and, just as importantly, 
the originator cannot deny that he or she was the source for the data.

For an explanation of how to set up public/private key encryption, see “Setting up encryp-
tion” on page 23 and “Setting up decryption” on page 24. For an explanation of dual-key 
encryption, see “Background on Public/Private Key Encryption (1024 bit)” above.

Defining study data to be exported
At the heart of every joint research study is a definition of the data 
of interest. Otobase allows you to create Clinical Group Checklists, 
Searches and Exports so study participants can:

•  Identify and control the entry of data pertinent to the study 
(Clinical Group Checklist).

•  Retrieve any record in the database that fits the study defini-
tion (Clinical Group Search).

•  Define exports for sharing the data with others involved in the study (Clinical Group 
Export).

Let’s briefly examine each:

Clinical Group Checklists
Especially in the case of a clinical study, it is important to make sure saved records meet min-
imum criteria. To simplify and enforce this process, Otobase allows the administrator to cre-
ate Checklists that review a data entry form when it is being saved, and prompt the user if any 
of the minimum information is missing. These Checklists can then be assigned to the Clinical 
Group so all members are screening their data using the same criteria. For instructions on 
creating a Sequential Search/Checklist, see Page 26.

Background on Public/Private Key Encryption (1024 bit)
Data can be encrypted with different degrees of security. Simple encryption schemes involve use 
of a mathematical algorithm to encode messages and a single “key” for both coding and decod-
ing. If you know the formula to encode the message and you know the encryption key, you can 
decode the message by reversing the process.

Public/private key encryption is much more sophisticated. A computer generates a paired 
encryption key and decryption key. Once a message is encrypted with the encryption key, the 
only way to decrypt the message is to use the paired decryption key. Even if the algorithm used 
to encrypt the message is known, having the encryption key does not help you. In fact the desig-
nation of “encryption” and “decryption” keys is deceptive since either key can be used in some 
schemes to successfully encrypt a message as long as its paired key is used to decrypt the mes-
sage. To help distinguish between the actual roles in a key pair, the encryption key is called the 
“private” key and the decryption key is called the “public” key.
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Clinical Group Search
Once records are saved, retrieving them is a process of defining fields and/or values to look 
for, and then narrowing the search by looking for related records in other parts of the data-
base. An entire chapter in the Otobase User Guide is devoted to this process (see Chapter 4, 
“Searching”). Once you have defined a search, you can save the search definition. The result-
ing Saved Search is the key building block of a Sequential Search, which can perform a series 
of Saved Searches within a single table of the database and then combine the results to create 
a final set of records meeting the combined criteria. The Clinical Group Search further auto-
mates the process by allowing you to define a Sequential Search of multiple tables that can 
find all data of interest to the study with one easy search. (see Page 26 for instructions on cre-
ating Sequential Searches).

Clinical Group Export
 After you build the searches that will 
allow participants to find data of 
interest, exporting data involves 
searching for records, and then select-
ing the fields to be exported and an 
export format. To automate this pro-
cess for a study, Otobase has a feature 
known as a Grouped Export. It is cre-
ated from a series of Saved Exports in 
the same way that a Sequential Search is created from a series of Saved Searches. The steps 
involved in creating a Grouped Export can be found on Page 27.

Assigning the Checklist, Search and Export
After creating a Clinical Group Checklist, Search and Export, the study coordinator assigns 
them to the Clinical Group record (see “Assigning a Clinical Group Search and Export” on 
page 29 and “Assigning Checklists” on page 30). To share these “study tools” with partici-
pants, the study coordinator can export all three using a single menu item. Otobase creates a 
special document that bundles all three items into a single file and encrypts them using the 
coordinator’s private key if data encryption has been set up for the trial. Participants who 
have received the public key from the coordinator and entered it in the study’s Clinical Group 
form may then import the bundled Checklist, Search and Export definitions into their ver-
sion of the database, and all three will be automatically decrypted (see “Exporting study 
tools” on page 31 and “Importing study tools” on page 35).

The Otobase TRANSFER file format
Otobase uses a special TRANSFER file format for sharing data between participants in a study. 
The TRANSFER files can be encrypted and decrypted, inspected for content before being 
imported into the receiver’s database, and can include checksum data with or without the actual 
record data. To learn the steps involved in manually exporting data using the TRANSFER for-
mat, see Part 2 starting on Page 8.
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Checksums
Checksums are an extremely helpful tool in verifying that the data sent from one computer 
arrives at another computer without being changed. In essence, checksums are a mathemati-
cal way of analyzing a data stream and reducing it to a single, representative long integer (+/- 
2,147,483,647). The data stream is made up of data bits, each equal to 0 or 1. By processing a 
series of repeated calculations using a specially selected “polynomial,” a computer can exam-
ine a data stream and detect the change in a single bit. In the case of multi-site clinical studies, 
checksums can also be used to make sure that subject data sent from various sites is never 
changed after first being collected.

Checksums are most often used in data transmission where a data stream is sent followed by 
its calculated checksum. The receiving computer calculates its own checksum on the data 
stream and compares it to the received checksum. If the two match, the data stream has 
remained unchanged during transmission and is therefore valid.

The same theory underlies the use of checksum calculations in Otobase for entire database 
records and exported data field subsets. All records or fields exported in a TRANSFER-type 
export document include their unique internal ID fields in addition to the requested export 
fields. Calculating a checksum on all of these fields virtually guarantees that a record or 
selected subset of data fields cannot be modified without changing the checksum. It is impor-
tant to realize that subtle changes such as capitalizing a letter in a text field result in a com-
pletely different checksum calculation.

If checksums are used it is not even necessary for participating institutions or individuals to 
exchange the actual data until the conclusion of a study. Instead, a CHECKSUM-type export 
document can be exchanged with the coordinating institution. At the conclusion of the study 
the actual data can be exchanged and the checksums compared to verify that no data has been 
altered. For the steps in creating a CHECKSUM-type export, see Page 10. For a more 
detailed explanation of the theory behind checksums and their implementation, see Chapter 9 
in the Otobase User Guide, “Database Design and Theory.”
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Sharing data manually using special formats
Even though Otobase allows you to automate the sharing of data for a trial (see Part 3, “Set-
ting up a trial using automated features” on page 18), it is useful to understand the manual 
procedures for exporting and importing data using the TRANSFER or CHECKSUM for-
mats.

A TRANSFER document can only be read in another version of Otobase. This offers one 
level of security, and we will also explain how to encrypt a TRANSFER document to further 
protect the confidentiality of subject data.

For a more complete explanation of some of Otobase’s other exporting and importing func-
tions, see Chapter 5, “Exporting and Reporting,” Chapter 7, “Administrator Functions,” and 
Chapter 9, “Database Design and Theory” in the Otobase User Guide.

Selecting data for manual export
Exporting data manually is a process of searching for records, selecting an export format, 
then exporting the data. Follow these steps to select the data for export regardless of the for-
mat you will choose.

To select data for export

1. Select Reports > Export Data.
The Search for Export form opens.

2. Create a set of records to export (see Chapter 4, “Searching,” in the Otobase User 
Guide).

3. Drag the set of records to Drop Export Set.
The Export Data form opens.

The Export Data form has two tab selections: Field Info and Export Format. Field Info 
allows you to choose specific fields to include in the export. Export Format allows you to 
select the format for export.

A pop-up above the field list controls the display of the data fields for export. To begin with, 
it reads “Master Table.”

Part 2
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You can choose from two other options:

• “Master table, sorted” displays the data fields for the master table in alphabetical order. 
• “Related tables” once again displays the master table data fields in their native order 

(the order in which they appear in the database), with the addition of nested sublists 
denoting relationships with related tables.

 You can select data fields for export in the following ways:

• Drag a single field name from Select the Fields on the left to Export Field List on the 
right.

• Click a single field name from Select the Fields while holding down the Shift key.
• Select a single field name from Select the Fields and click the single arrow.
• Click on the double arrow to move all fields to the Export Field List. 

Using the single arrow or shift-clicking on a field will add fields in the order they were 
selected. You can also drag a field from left to right, and it will be placed above the field it is 
dropped on. You can change the order of the fields in the list on the right by dragging them 
to a new position. 

When the list fills the screen, you can add a new field name to the end of the list (no matter 
where you drop it) by dragging while holding down the Shift key. 

To remove fields from the Export Field List, do one of the following:

• Drag a single field to the Trash in the lower right of the form.
• Click on a single field in the Export Field List while holding down the Shift key.
• Click Clear in the upper right to remove all fields in the list.
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Selecting format for export
Otobase can export data files in a number of different formats depending on how the data 
will be used. In the Export Data Form, select the Export Format tab.

Depending on the format you choose, different options will appear. The first two formats are 
CHECKSUM and TRANSFER, which are used for sharing data with other participants in a 
study using Otobase. The last three formats, DIF, SYLK, and TEXT, are all text formats, 
which can be imported by spreadsheets and statistical packages as well as other databases. We 
will examine only the first two options. For an explanation of all export functions, see Chap-
ter 5 in the Otobase User Guide, “Exporting and Reporting.”

Exporting the CHECKSUM format
The CHECKSUM export type is unique to Otobase and is primarily used to report interim 
data in a clinical trial. Exporting CHECKSUM files allows both the sender and recipient to be 
sure that the data has not been tampered with or changed without having to share the actual 
data. For more information on how checksums work, see Chapter 9 in the Otobase User 
Guide, “Database Design and Theory.”

When exporting checksums, you have two options:

• Export as text document
• Complete records

If you choose Export as text document, Otobase generates a tab-
delimited text document that includes the checksum information. 
This text document can be opened by any word processing or 
spreadsheet program.

If you do not choose to Export as text document, Otobase gener-
ates the checksum in a TRANSFER document, which can only be 
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interpreted by Otobase. Although both CHECKSUM formats include the same information, 
the text file format can be tampered with. To ensure a higher level of security for your check-
sum data, do not check “Export as text document.”

When you export the checksum as a TRANSFER document, the recipient can open the doc-
ument in Otobase, extract the checksum information, and place this information in a text 
document for analysis. The recipient can also compare the checksum information with data 
records they have already imported in the past to check for changes. For more information, 
see “Importing a TRANSFER document” on page 14.

Selecting the “Complete records” option sends the check-
sum stored internally for the entire record in the database, 
rather than calculating checksums for the individual fields 
selected for export. If you are participating in a clinical trial, 
selecting this option allows you to send secure information 
about your files without sending all the data in the files.

Exporting the TRANSFER format
The TRANSFER format is unique and can only be inter-
preted by Otobase. When exporting TRANSFER docu-
ments, you have two options:

• Complete records
• Include Checksum info.

If you check Complete records, Otobase exports all fields in a 
record and ignores the export field list with one exception (see 
“Complete records require one field” above).

Include Checksum Info is selected by default. This option offers a 
number of advantages for the person importing these files in a 
clinical study. First, since the checksum information can be placed 
in a text file, the person importing the data can check to see what 
is in the TRANSFER document, prior to importing the records. 
Second, the person importing the checksum for an imported 
record can compare it to the checksum from any pre-existing 
records. In this way, the data for import can be checked prior to 
updating or replacing records and previous secure data will not be lost. Additional import 
options are available based on this checksum analysis (see “Importing a TRANSFER docu-
ment” on page 14).

Saving exports
Often you may need to export the same group of fields on more than one occasion. The 
Saved Export feature allows you to save the settings for common exports.

“Complete” records
Since TRANSFER docu-
ments may include data 
from more than one table, 
the field list is evaluated for 
the tables exporting com-
plete records. Because of 
this, to use the Complete 
records option you must 
specify at least one field 
from each table used in the 
export.
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Export settings can be saved in as database records, or they can be saved to disk to allow 
sharing with other Otobase users, specifically ones who may be participating in the same 
study. Saving an Export will store both the specified export fields and format. 

To save an export to a database record

1. Complete the Export Data form by choosing fields and selecting a format.
2. Click Save. 

A Request dialog appears.
3. Enter a unique name for this export and click OK. If you use the name of an existing 

Saved Export you will be asked if you want to replace the older version of that Saved 
Export. 

To load an export from a database record

1. On the Export Settings form, click Load.
A pop-up list of available Saved Exports for 
that master table appears.

2. Select the appropriate Saved Export.

Note: Use the Refresh List selection if you believe there is a Saved Export available, 
but it does not appear in your pop-up list. This is rarely necessary in a client-server 
environment.

Saving and loading Saved Exports outside Otobase
Administrators and subadministrators can save the export settings used to create Saved 
Exports to a file on their computer and then reload them. This is useful when exchanging 
data in multi-site trials. By using this function, you can avoid having to rebuild the exports 
that are used to create Saved Exports.

To save a Saved Export to disk

1. Open the Preferences form (File > Preferences).
2. Click Export/Grouped Export.
3. Open the Saved Exports list in the box on the right 

by using the plus sign (Windows) or arrow (Mac).
4. Find the Saved Export you wish to save to a file on 

your computer by opening the tables that have plus 
signs or arrows next to them.

5. When you have found the Saved Export, double-
click it to open the Edit Export Settings form.

6. Click File > Save to Disk.
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7. In the Save As dialog, browse to a destination folder, name the file, and click Save.
The export settings used to create the Saved Export will be saved in a special format 
that allows them to be reloaded into Otobase.

To load a Saved Export from disk

1. Open the Preferences form (File > Preferences).
2. Click Export/Grouped Export.
3. Open the Saved Exports list in the box on the right by using the plus sign (Windows) 

or arrow (Mac).
4. Find the table that matches the one used to create the 

Saved Export you are loading, then do one of the follow-
ing:

•  With the table name highlighted, click New Saved 
Export to open a blank Edit Export Settings form.

•  Double-click on a Saved Export name within the 
table to open an existing Edit Export Settings form.

5. Click File > Load from Disk.
6. In the Open dialog, browse to the file that contains the Saved Export you wish to 

load, and click Open.
The Edit Export Settings form will change to reflect the settings from the file you 
loaded.

7. Click Save. 
A Request dialog appears.

8. Enter a unique name for this export and click OK. If you use the name of an existing 
Saved Export, you will be asked if you want to replace the older version of that Saved 
Export. 

If you are trying to share files between platforms (for example, 
Windows to Mac), the normal Open dialog may not show the file 
you are looking for. This affects several menu items:

• File > Load from Disk
• Import/Export > Import TRANSFER Doc
• Import/Export > Encrypt TRANSFER Doc
• Import/Export > Decrypt TRANSFER Doc
• Import/Export > Decrypt a Grouped Export
• Clinical Group > Import Study Tools

In this case, hold down the Shift key while selecting the menu 
item. This forces the Open dialog to display all files.

Special 
note on 
Windows 
vs. Mac
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Importing a TRANSFER document
This menu item allows you to open, examine and import TRANSFER-type export docu-
ments that contain data records and/or checksum data. Selecting this item will open the stan-
dard dialog to let you choose a file to import.

After you choose the file, the Import TRANSFER Doc dialog appears, giving you three 
options:

• Checksum Info import records
• Checksum Info current records
• Import the record data.

Here is a look at how the three options work:

Checksum Info Import Records
This option allows you to simply examine the TRANS-
FER document to see what information it contains 
before taking steps to import it. Selecting this option 
then clicking the Create Text Doc button will generate a 
tab-delimited text file that will include the required inter-
nal ID fields for each record that has been exported, 
along with the checksum for the exported data fields. If 
data fields were exported without checksum calculations, the text file will so indicate. Here is 
an example of the text file this option generates:

The file includes:

• File type identification and date of export.
• The table(s) included in the export and their exported field numbers. In this example, 

only Tumor_Description fields were included in the export since we were only export-
ing records from the Tumor Description table. Six fields were included in the exported 
data and the checksum calculations: 1 (Subject_ID), 5 (Tumor_No), 9 (Primary_site), 

 Record Export Checksum Info
 Export date: 04/25/1999:
 
 Tablename Exported Field Numbers
 Tumor_Description 1,5,9,16,17,18,
 
 Tablename ID Field #1 ID Field #2
 Tumor_Description Subject_ID Tumor_No
 
 Tablename ID Field #1 ID Field #2 Checksum for exported fields
 Tumor_Description 251000 174000 81827828
 Tumor_Description 275000 215000 1520154295
 Tumor_Description 277000 218000 584311072
Tumor_Description 38000 224000 1094207930
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16 (T Stage), 17 (N Stage), and 18 (M Stage). These are the four fields specified on the 
Export Settings form plus the two required ID fields for the Tumor_Description table.

Note: The ID fields could have been explicitly included in the Export 
Settings. Since they were not, the required ID fields were automati-
cally added.

•  Names of the required ID fields for the included table(s).

Checksum Info Current Records
This option allows you to compare the exported records to the records that they would 
replace if you imported them. Selecting this option then clicking the Create Text Doc button 
will create a tab-delimited text file containing the required internal ID fields for each record 
exported. The text file will also show the calculated checksum for any existing records with 
the same internal IDs currently residing in the destination data file that would be updated if 
the “new” record data were imported. In addition, if the checksum data was included in the 
TRANSFER-type document, Otobase will compare the existing destination data file record 
fields and the data fields that would be imported from the TRANSFER-type file. Here is an 
example of the text file this option generates:

You can use the information in the “Previous record status” column to verify any changes in 
previously shared data. Note the number “2” in the second to last record; this indicates that 
the checksums did not match and something has changed.

Import the record data
Selecting this option gives you three more choices before you import data. Otobase uses the 
required internal ID fields that are always included in the TRANSFER type document to 
search for an existing record in the data file. The three options differ in how they affect exist-
ing records:

 Record Export Checksum Info
 Export date: 08/25/1999:
 
 Tablename Exported Field Numbers
 Tumor_Description 1,5,9,16,17,18,
 
 Tablename ID Field #1 ID Field #2
 Tumor_Description Subject_ID Tumor_No
 Previous record status: 0=none, 1=found w/ same checksum, 2=found w/ different checksum, 3=more 
than one record found
 
 Tablename ID Field #1 ID Field #2 Checksum for Previous record 
 exported fields status
 Tumor_Description 251000 174000 81827828 1
 Tumor_Description 275000 215000 1520154295 1
 Tumor_Description 277000 218000 584311072 2
 Tumor_Description 38000 224000 1094207930 0
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• Replace without warning: This will update 
the data fields in existing records with the 
imported data without warning the user.

• Replace with warning: This will warn the user 
before each update is performed. The user can 
choose to skip that record or update it accord-
ingly. The displayed confirmation dialog will 
include the required internal ID fields for that 
record.

• Do not replace: This will leave any existing 
records untouched.

If no existing record is found, Otobase creates a new one and populates it with the imported 
data fields. 

Note: If the TRANSFER type document does not include the actual record data, the 
Import the record data option will be disabled.

Encrypting a TRANSFER document 
To ensure the security of clinical data being shared by disk, e-mail or networked computers, as 
well as for verification purposes, Otobase allows you to encrypt TRANSFER documents. 
Otobase will manually encrypt a TRANSFER document when you select this menu item. For 
this function to work, the Clinical Group you are encrypting the document for must be desig-
nated as a study (see “Designating the group as a study” on page 22).

To encrypt a TRANSFER document

1. From the Administrator Menu Bar, click Import/Export > Encrypt TRANSFER 
Doc.
An Open dialog appears.

2. Select the TRANSFER document you want to encrypt.
3. A Select From List dialog appears with the 

names of Clinical Groups that have been des-
ignated as studies and have private (encryp-
tion) keys.

4. Click the appropriate group name on the list, 
and click OK.
The encrypted document will replace the 
unencrypted copy.
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Decrypting a TRANSFER document 
An encrypted TRANSFER document can be manually decrypted using this item. First, a 
standard dialog will be presented to let you select the TRANSFER document to be 
decrypted.

The encrypted TRANSFER document includes information that is used to select the proper 
decryption key. The decryption key to be used is identified by:

• The Clinical Group’s List Name, which should be the same for all the participants in a 
multi-site trial.

• The study participant’s ID.

The decrypted document will replace the encrypted copy. 
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Setting up a trial using automated features
Otobase uses such automated features as Grouped Exports and Export/Import Study Tools 
to streamline the process of setting up trials. Part 1 of this manual explained some of the con-
cepts behind setting up a trial; this section offers step-by-step instructions for both the study 
coordinator and participant.

First, we’ll look at the steps that a study coordinator goes through to set up the Clinical 
Group record, encryption, searches, exports and other tools for running a trial, and then we’ll 
examine the steps for study participants starting on Page 34. For visual overviews of the 
steps, see “Steps in setting up a clinical trial: Study coordinator” on page 19 and “Steps in set-
ting up a clinical trial: Participants” on page 34.

Steps for the study coordinator
The study coordinator will use his or her copy of Otobase to set up the Clinical Group record 
for the trial and then share this information with participants. The coordinator also builds the 
study search, checklist and export definitions and then shares these with participants using 
the Export Study Tools function. Once encryption and decryption have been set up, sharing 
of data can begin, with participants sending their encrypted exports to the coordinator, who 
maintains all records associated with the study (or at least the checksum information for the 
records).

We will begin the section describing how the coordinator can make sure that data being col-
lected for the study remains separate from his or her own subject data in Otobase.

Keeping study data separate
To ensure the integrity of the data being shared in a multi-site clinical trial, it is recommended 
that the study coordinator create a new clinical trial data file to use with his or her original 
version of Otobase.

Keeping the data separate will simplify long-term management of a study, especially if the 
study coordinator is running multiple studies at the same time. A separate data file also 
ensures that records not involved with the study will not be accidentally affected by data 
import.

Part 3
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To create a new data file 

1. Double-click the Otobase icon on your computer.
The Password dialog appears.

2. Log in as the administrator.
3. Enter the administrator password for the data file you were last using.
4. While holding down the Alt key (Windows) or Option key (Mac), click Connection.

Otobase opens and the Open data file dialog appears.
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5. Select New…
The Create a data file… dialog appears.

6. Browse to a location where you wish to save the new file. 
7. In the Name field, type in a unique name for the new data file.
8. Click Save.

You will be prompted that there are no passwords assigned to the new data file, and 
asked about synchronizing the data and structure files.

9. Click Yes.
10. Follow the dialogs asking you to enter and confirm a new password.
11. Enter a new Participant ID number between 0 and 999, and click OK.

Note: You can always reconnect to previously created data files by holding down the 
Alt key (Windows) or Option key (Mac) and browsing to a different data file.

Create file dialogs: Windows (right), and Macintosh

Be careful when switching between data files
Although it’s a good idea to use a separate data file for the study, managing more than one data 
file can be tricky. Here are two cautions:
First, be sure when switching between data files that you are using the correct file to enter study 
data or nonstudy data. To check which data file you are using, click Help > About Otobase (Win-
dows) or Apple > About Otobase (Mac) and select the Folder Info tab.
Second, if you use different passwords for the various data files, keep a record of them. Oto-
base remembers the last data file it was connected with and will require you to use the pass-
word associated with that file to initially log in. When you switch to a different data file, you’ll 
have to enter a password for that file after Otobase synchronizes the data and structure files.
If you are ever at a total loss to recall which data file you were last connected with and cannot 
log in because you are using the incorrect password, follow these steps:

1. Uninstall Otobase (this will not affect your data files).
2. Reinstall the program.
3. Use the initial Administrator/Otolith2 login and password combination.
4. Browse to whatever data file you wish to work with and click Open to connect with it.
5. Following synchronization of the structure file and data file, log in with the password stored in 

that data file (or create a new password at this time).
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Setting up the Clinical Group record
This section will first show you how to create a new Clinical Group record, and will then 
explain how to fill out the record in preparation for a trial and set up encryption/decryption 
keys. The finished Clinical Group record will also have the study group’s search, checklist and 
export definitions. These will be explained starting on page Page 26.

Note: Only users logged on as administrator or subadministrator can create a new 
Clinical Group record. For an explanation of the different user classes in Otobase, 
please refer to Chapter 1, “Getting Started,” in the Otobase User Guide.

To create a new Clinical Group record

1. With the Home Window or 
Subject List open, Select File > 
Clinical Group Info.
The Clinical Group List form 
appears, with a list of all Clini-
cal Groups and buttons to add, 
modify or delete groups. 
Group administrators will be presented with the list of Clinical Groups they adminis-
trate.

2. Click New.
A New Clinical Group form appears. You can open an existing Clinical Group Infor-
mation form by double-clicking on a group name in the list, or selecting the name 
and clicking Modify.
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The Clinical Group form has three tabs, Group Info, Study Export and Study Import. The 
administrator and subadministrators can view, copy and change all of the fields on the second 
and third tabs of the form. Group administrators cannot access any of this information.

Choosing a unique list name
The Clinical Group form has two boxes for naming the group: Institution or Study Name, 
and List Name. We recommend that you choose a List Name that contains numerals or sym-
bols and cannot be confused with the name of another institution or group. Study partici-
pants will need to use this same List Name in the data files they are using for this particular 
study, so the coordinator must ensure the name doesn’t conflict with names that participants 
may already be using. It is also a good idea for the study coordinator to use part of the List 
Name as part of the name of searches, exports and checklists that are associated with the 
study to make sure these don’t conflict with other such items in participants’ data files. We 
recommend that a prefix be used as part of all records associated with the trial, for example 
UW02_GroupSearch, UW02_GroupExport, etc.

Designating the group as a study
Selecting the “Clinical Group is a study” checkbox on the Clinical 
Group Information form allows Otobase to substitute Study Partici-
pant IDs when it encrypts data for export, and is also important in 
automating the encryption process.

In addition, selecting this checkbox makes it easier to search for all subjects in clinical studies.

Assigning Study Participant IDs
The Study Participant ID ensures that each site taking part in a study is uniquely identified. 
This enables Otobase’s encryption/decryption feature to work properly. The coordinator 
should assign a unique number to each participant, including him or herself. We recommend 
the coordinator take the number 0 and begin with the number 1 for assigning IDs to partici-
pants.

Note: All participants in a study must select the “Clinical Group is a study” checkbox 
on the Clinical Group form to allow the substitution of Study Participant IDs in 
exported data, as well as the automation of the encryption process.

To assign a Study Participant ID for exported data

1. Log onto Otobase as Administrator.
1. On the Clinical Group form, click the Study Export tab.
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2. Make sure the form is unlocked by clicking on the black, closed lock icon.
3. Enter a number between 0-999.
4. Click OK to save the change.

Setting up encryption
The process of encryption/decryption of data begins on the Clinical Group form. Follow 
these steps to generate a public/private key pair.

To generate public/private key pairs

1. On the second tab of the Clinical Group form (Study Export), make sure you have 
entered a Study Participant ID.
The Generate Keys button is enabled.

2. Click Generate Keys.
Otobase creates a public/private 1024-bit encryption key pair.

3. Do one of the following:
• Click Save Public Key to Disk to generate a text file that you can use to share the 

public key with whoever will be importing your data.
• Highlight the public key, copy it, and then paste it into an e-mail message or other 

word processing program for sharing.
4. Click OK to save the keys in the Clinical Group form.

If you try to modify previously created keys you will be warned before saving the 
record since an inadvertent change will destroy the utility of the paired keys.

Sharing the group record
Once the coordinator has set up a clinical group record, he or she needs to share its 
data so participants can set up matching records. The minimum information partici-
pants will need is the study name, the unique list name and their Study Participant 
ID, plus the exported study tools (see “Exporting study tools” on page 31). If the 
study will use e-mail communication, the coordinator’s e-mail information should 
also be included.
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Setting up decryption
The third tab of the Clinical Group form allows you to set up decryption of shared data. On 
this tab:

•  The study coordinator can enter the names and Study Participant IDs of all those 
involved in the study, as well as enter or modify participants’ public keys to allow 
decryption of their data.

•  Participants can enter the coordinator’s public key to enable them to decrypt study 
tools or other data sent from the central collection site.

Study participants should generate their own key pair and send the public (decryption) key to 
the study coordinator. The coordinator can then import the participant’s public key using the 
following procedure.

To add Study Participant IDs and public decryption keys

1. On the third tab of the Clini-
cal Group form, click Add 
Participant to begin the pro-
cess of entering the partici-
pant’s name, ID number and 
public key.
A dialog appears for entering 
the participant’s ID.

2. Enter the ID and click OK.
3. Click Modify Participant 

Info.
4. Enter a name in the dialog and click OK.
5. Click Modify Public Key.

A dialog will ask you to confirm that you want to modify the public key for this par-
ticipant.

6. Click OK.
7. Copy the public key that this participant has sent to 

you, paste it into the Public Key dialog, and click OK
The Key Status column at right will show the italicized 
word “Yes” to indicate that you have stored the partici-
pants’s key.

Clicking Save Public Key to Disk allows you to create a text file with the selected participant’s 
public key. The file can then be distributed on disk or opened in a word processing program 
for copying and pasting. You can also remove a participant from the list by clicking Delete 
Participant ID.



 CLINICAL TRIALS · 25

ClinicalTrials.book  Page 25  Tuesday, April 23, 2002  11:59 AM
Setting up study e-mail
The second page of the Clinical Group form allows you to enter the e-mail address of a cen-
tral data collection site for the study. If participants choose to export data automatically via e-
mail enclosures, it will be sent to this address.

Ideas for using Otobase’s encryption tools

Verifying data using encryption keys (without sending the data)
Otobase’s checksum feature gives you a powerful tool for verifying unshared data (see Page 7). 
The checksum information can be shared by itself in a text document form or sent as a TRANS-
FER document.
If the checksum information is sent as a TRANSFER document it can be encrypted and 
decrypted just like a TRANSFER document with data. The encryption/decryption process 
means that the same level of verifiability pertains to the checksum information by itself.

Backing up data at a central location using encryption keys
If participants choose to maintain their independence by sending only checksums until the end 
of a study, it is crucial that each site can guarantee that their complete data sets will be pro-
tected from loss since they have the only copies. As a safeguard, the study coordinator can ask 
participants to encrypt complete records with a public/private key combination that is not being 
shared with the coordinator.
To accomplish this the participant should set up an additional “shadow” Clinical Group record 
that will include the same Sequential Search and Study Participant ID as the original study 
group. The group export can be the same or can include other fields or complete records. These 
encrypted records can then be sent to a central storage location as an additional source of data 
backup. If the original records are ever lost, the encrypted backup copies can be sent to the 
originator, who can decode them and reload them in his or her database. Alternatively, the 
decryption key can be given at that time to the study coordinator along with the records (see 
below). To further guard against the possible loss of access to the encrypted data due to mis-
placement of the unshared public (decryption) key, the originator can arrange to send the public 
key to a trusted third party who will not release it without the originator’s consent.
The choice of which Study Participant ID to use depends on who the intended recipient of the 
backup records will be. If the originator will be re-importing the backup copies, the Study Partic-
ipant ID should be left blank. If the study coordinator will be receiving the backup records, the ID 
should be the one assigned in the original study. In this case, the study coordinator will set up a 
new Clinical Group record for the “shadow” Clinical Group with the same List Name used by the 
participant. The backup decryption key is entered on this form.
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Maximum attachment size
Some e-mail systems limit the size of e-mail enclosures (attached documents). The default 
value is 128 Kb. If an export document exceeds the specified size the document will be split 
into multiple enclosures and reassembled when it is imported.

Single attachments only checkbox
Some e-mail systems limit the number of e-mail enclosures (attached documents) per e-mail. 
Selecting this option causes export document(s) to be sent out as a series of separate e-mails. 
This is rarely needed and increases the time needed for the export. Do not choose this option 
unless you are certain that you need to.

Creating a Clinical Group Search and 
Checklist
The Clinical Group Search and Clinical Group Checklist are 
both Sequential Searches, built from individual Saved 
Searches. Otobase executes multiple Saved Searches for a 
table separately, and then combines the resulting sets using 
the “AND” operator. A Checklist, instead of searching for all 
records meeting certain criteria, ensures that a new record being saved in Otobase meets the 
criteria to begin with.

This section will explain how to build a Sequential Search. Because the process of building a 
Checklist is essentially the same, it will not be explained separately (although the Checklist 
must be assigned to an individual Provider record for it to work). For more information, see 
Chapter 2, “Providers and Clinical Groups,” Chapter 4, “Searching,” and Chapter 6, “Prefer-
ences,” in the Otobase User Guide.

To create a Sequential Search

1. Open the Preferences form by clicking File 
> Preferences from the Home Window or 
Subject List menu bars.

2. Click Search/SeqSearch-Checklist in the 
list on the left side of the form.

3. Select Checklist/Sequential Searches from 
the list on the right, and click New Check-
list/SeqSearch.
The Sequential Search/Checklist creation 
form appears, with a list of any Saved 
Searches in the database (organized by 
table). An item with a plus sign (Windows) 
or arrow (Mac) contains a sublist of Saved Searches.

If you’ve already created the 
group’s Checklist, Search 
and Export, skip to the sec-
tions about assigning them 
to the Clinical Group record 
on Page 30.
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4. From the Saved 
Searches list on the left, 
use the plus signs or 
arrows to open list 
items and find the 
Saved Search(es) that 
you created.

5. Drag the Saved 
Searches you wish to 
assemble into a 
Sequential Search to the 
list on the right.
You can change the 
order of the Saved Searches by dragging them to a different position in the sublist.

6. When you have built your Sequential Search, click Save.
7. Using the dialog, name the search, then click OK.

Note: It is important to name Sequential Searches, Checklists and any 
individual Saved Searches in a unique manner to avoid conflicts when 
sharing them with participants in the trial. We suggest using a prefix 
such as UW02_.

8. Click Finished.
The newly created Sequential Search or Checklist 
search appears in the list on the Preferences form.

The administrator or subadministrators can modify 
Sequential Searches and Checklists from the Sequential Search/Checklist form by adding new 
Saved Searches or dragging old ones to the Trash.

To delete a Sequential Search or Checklist, open the form and select Delete.

Creating a Clinical Group Export
After defining the searches that allow participants to save and find data of interest to the 
study, you can use the same searches to define the data that will be exported from each site’s 
version of Otobase. Exporting data involves selecting an export format and defining the 
fields to be exported from each table. For an explanation of setting up an individual export, 
see “Sharing data manually using special formats” on page 8, as well as Chapter 5, “Exporting 
and Reporting,” in the Otobase User Guide.

The export you will assign to all participants in the study is a special Otobase function known 
as a Grouped Export. It combines Saved Exports from multiple tables within the database 
and allows study participants to export all data relevant to the study with just a few clicks (see 
“Exporting a Grouped Export” on page 36).
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The following procedure explains how to set up a Grouped Export.

To create a Grouped Export

1. Click the Export/Grouped Exports list item on the Preferences form.
2. Select Grouped Exports from the list on the right, and click New Grouped Export.

The Grouped Export form displays.

3. From the Saved Export list on the left, use the plus signs or arrows to open list items 
containing Saved Exports.

4. Drag the Saved Exports you wish to assemble into a Grouped Export to the list of 
tables on the right.
Otobase will only allow you to drag a Saved Export to the table it was created from, 
and you can only drag one Saved Export per table. If a Saved Export includes fields 
from related tables, these fields are ignored in executing a Grouped Export.

5. When you have built your Grouped Export, click Save.
6. Using the dialog, name your Grouped Export, then click OK

Note: It is important to give Saved Exports and Grouped Exports 
unique names so they don’t conflict with other such exports already 
being used by participants in the trial. We suggest using a prefix such 
as UW02_.

7. Click Finished.
The name of the new Grouped Export appears in the sublist on the Preferences 
form.

The administrator or subadministrators can modify previously saved Grouped Exports from 
the Grouped Export form by adding new Saved Exports or dragging old ones to the Trash. 
To delete a Grouped Export, open the form and select Delete.
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Assigning a Clinical Group Search and Export
Once the study coordinator has defined the Clinical Group Search and Export, he or she can 
assign them to the Clinical Group record. We will explain the procedure for assigning a 
Search; the steps for assigning an export to the group are nearly identical.

To assign a Clinical Group Search

1. Create a Sequential Search for the group (see “Creating a Clinical Group Search and 
Checklist” on page 26).

2. On the Clinical Group 
Information form, 
click Clinical Group 
Search.
A form appears with 
the name of the Clini-
cal Group at the top, 
and a list of the 
Sequential Searches 
stored in the database.

3. In the left-hand list, 
click on the Sequential 
Search you wish to 
assign to the Clinical Group.
You can view the Saved Searches used to define the Sequential Search in the right-
hand list by using the arrows or plus signs to open tables that contain the searches.

Note: To review the contents of an individual search, double-click on 
the name of the search, in this example “UW02_Subjects.” The search 
will open. You cannot edit the search here, just review it. 

4. Click Update SeqSearch Selection.
The text on the Clinical Group Search button changes to 
italics to signal that a search has been assigned.

You assign Grouped Exports to Clinical Groups using the same procedure, starting with the 
Clinical Group Export buttons on the form. These are used for selecting complete or partial 
datasets for export to a coordinating institution in a multi-center clinical study. 



30 · OTOBASE

ClinicalTrials.book  Page 30  Tuesday, April 23, 2002  11:59 AM
Assigning Checklists
Once you have created a checklist, you must assign it to a Clinical Group, and then to Provid-
ers, to make it properly test for your criteria.

To assign a Checklist to a Clinical Group and Providers

1. Select File > Clinical Group Info to open the Clinical Group List, then double-click 
on the group you wish to assign the checklist to.
The Clinical Group form opens.

2. Unlock the Clinical Group form by clicking on the black lock.
3. Click Clinical Group Checklist.

A form opens with a list on the left of all Checklists saved 
in the database.

4. Click the Checklist you would like to associate with this 
Clinical Group.
The Checklist Definition box displays all tables, with sublists attached to the tables 
that contain the Saved Searches comprising your checklist. You can double-click a 
Saved Search to display it and check the criteria.

5. Click Update Checklist Selection.
The Clinical Group form appears again. The text on the 
Clinical Group Checklist button has changed to italics to 
signal that a Checklist is associated with this Clinical 
Group.

6.  Open a Provider Information form by selecting the File > Provider Info menu item 
and double-clicking on a provider name.

7. Unlock the Provider form and click Provider Checklist. 
The form that appears allows you to select a Checklist 
and decide whether to let the user to override it.
Whenever the user saves a record, Otobase will run the Saved Searches used to create 
this Checklist to enforce the criteria you set.

Using an assigned Checklist
You can pre-test a Checklist before saving a new or modified 
record or test it on a previously saved record by selecting the 
Data Checklist menu item found in one of the menus attached 
to the data entry form (for example, Subject > Data Checklist 
or Tumor > Data Checklist).

A Checklist pretest can always be dismissed by selecting the 
Close button. The administrator or a subadministrator has the 
option to enforce a Checklist when the record is saved 
(Recheck is the only option) or allow a user to save the record 
anyway (Accept is also an option).
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Exporting study tools
The study coordinator can export the Clinical Group Checklist, Search and Export using a 
single menu item. Otobase creates a special TRANSFER-type document with a file extension 
of OT3, which bundles all three items into one file and encrypts them using the coordinator’s 
private key if data encryption has been set up for the trial. Participants who have received the 
public key from the coordinator and entered it on the third tab of the Clinical Group form 
may then import the Checklist, Search and Export definitions into their version of the data-
base using the Import Study Tools item (see “Importing study tools” on page 35). The 
imported definitions will be automatically attached to the Clinical Group record.

To export the bundled Clinical Group Checklist, Search 
and Export

1. Make sure you have created all three items; the buttons on 
your Clinical Group record for this study should all be ital-
icized. Also make sure you have saved the Clinical Group 
record.

2. On the Clinical Group menu bar, click Clinical Group > Export Study Tools.
A Save As dialog appears, allowing you to browse to a location on your computer to 
save the OT3 file.

3. Choose a name for the file, and click Save.
The file is now ready for sharing with trial participants.

To see the procedure study participants will follow to bring the study tools package into their 
version of Otobase, see “Importing study tools” on page 35.

Importing study data
After all participants create matching Clinical Group records and send the study coordinator 
their public keys, sharing of data can begin. We will explain the process of importing and 
decrypting Grouped Exports, since this is the automated method of sharing study data. For 
an explanation of importing and decrypting TRANSFER documents manually, see “Import-
ing a TRANSFER document” on page 14 and “Decrypting a TRANSFER document” on 
page 17.

Importing a Grouped Export
Selecting this item from the Administrator Menu Bar will open a 
dialog that asks you to choose an import method, either Disk File, 
Disk File from e-mail, or e-mail. Depending on your choice, you will 
either browse to a folder containing the Grouped Export docu-
ments, or be asked to enter your password for your Otobase e-mail 
connection.

If you choose a Grouped Export document and all of the associated 
disk documents are in the same folder together, the Import 
Grouped Export form displays (see “Importing a TRANSFER doc-
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ument” on page 14 for information concerning the different options on the form, and a note 
about opening files saved in a different operating system).

If you select either of the two Checksum Info options on the Import GroupedExport form, a 
tab delimited text document will be generated for each of the Grouped Export TRANSFER 
documents and placed in the same folder with the Grouped Export’s TRANSFER docu-
ments.

Note: Each document making up a Grouped Export can be treated as an indepen-
dent TRANSFER document and imported manually. For the automated import func-
tion to work properly, however, all of the documents in the Grouped Export must be 
together in the same folder.

Decrypting a Grouped Export 
This menu item allows you to manually decrypt a Grouped Export document set. Manual 
decryption is necessary for Grouped Exports saved to disk, whereas e-mailed documents are 
automatically decrypted after downloading and conversion. Choosing the Decrypt a Grouped 
Export menu item will open a standard dialog allowing you to select one of the TRANSFER 
documents to be decrypted. This feature automatically verifies that all of the required docu-
ments are together before proceeding with decryption.

The decrypted documents will replace the encrypted copies.

Assigning subject records to the Clinical Group
After importing study data from participants that includes new subjects, the study coordina-
tor needs to assign all imported subject records to the Clinical Group record created for the 
study to make sure they are uniquely identified within his or her data file. You can do this 
using a menu item attached to the Clinical Group record.

To add subjects to a Clinical Group

1. Open the Clinical Group record for the study by 
double-clicking on the name in the Clinical 
Group List.

2. From the menu bar, select Clinical Group > Add 
Subjects to Group.
A Search for Subjects form opens.

3. Search for the set of subjects you wish to add and drag it to the Drop Selected Sub-
ject Set box on the form.
All subjects in the set will be assigned to the Clinical Group.
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Note: One way to search for the newly imported subject records is to 
create a set of all Clinical Groups and drag it to the Subjects table list, 
and then create a set of all subjects. By combining these two sets 
using the Difference function, you will have located all subjects not 
yet assigned to a Clinical Group. For more information on how to cre-
ate searches and combine sets, see Chapter 4, “Searching,” in the 
Otobase User Guide.

To remove a group of subjects from a Clinical Group

1. With the Clinical Group record open, select Clinical Group > Remove Subjects from 
Group from the menu bar.
A Search for Subjects form opens.

2. Search for the set of subjects you wish to remove and drag it to the Drop Selected 
Subject Set.
All subjects in the set are removed from the Clinical Group.
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Steps for the participants
For participants, setting up a trial is a relatively simple process because the study coordinator 
has already performed many of the tasks. You will create a matching Clinical Group record, 
set up encryption/decryption, and import study tools. After that, taking part in a study is a 
process of collecting data and sharing it with the study coordinator using a number of differ-
ent sharing options.

Here is a quick breakdown of the steps for a participant to set up a trial. For a visual overview, 
see the diagram below.

1. Create a new Clinical Group record.
•  Receive from the coordinator the information for the study’s Clinical Group 

record: study name, unique list name, Study Participant ID, and (optional) coor-
dinator’s e-mail information.

•  Enter the data received from the coordinator into the Clinical Group record in 
your data file (see “Setting up the Clinical Group record” on page 21).

2. Set up encryption/decryption.
•  Generate public/private key pair (see “Setting up encryption” on page 23).
•  Send your public key to the study coordinator.

Steps in setting up a clinical trial: Study coordinator

Create a new 
Clinical
Group record

Set up data
export for
the study

 Steps in setting up a clinical trial: Participants

Collect
and export 
study data

Receive
data from
coordinator

Create 
matching CG 
record

Import
study
tools

Generate
public/private
key pair

Send public 
key to
coordinator

Receive
coordinator’s
public key

Run
grouped
export

Encrypt
export
documents

Send study
data via e-
mail or disk

Set up
encryption/
decryption
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•  Receive the coordinator’s public key (see “Setting up decryption” on page 24).
3. Set up data export for the study

•  Use the “Import study tools” item on the Clinical Group Record menu bar (see 
Page 35).

4. Collect and export study data
•  Export study data as a Clinical Group Export (see “Exporting a Grouped 

Export” on page 36).
•  Encrypt export documents, which is performed automatically if you use a 

Grouped Export.
•  Send study data to the coordinator using Otobase’s internal mail system, or via 

disk documents (see “Tips on using e-mail to export and import shared study 
data” on page 36).

Importing study tools
Participants who have received the public key from the coordinator and entered it in the Clin-
ical Group form can import encrypted Checklist, Search and Export definitions into their 
version of Otobase using a single menu item. You should have received the OT3 file from the 
study coordinator, and placed it in a location that you can browse to during the process of 
importing the file.

To import the bundled Clinical Group Checklist, Search and Export

1. While logged on as administrator, open the Clinical Group record for this study and 
make sure it is unlocked.

2. On the Clinical Group menu bar, click Clinical Group > Import Study Tools.
An Open dialog appears, allowing you to browse to the location of the OT3 file sent 
by the study coordinator.

Note: If you are sharing the OT3 file between platforms.the normal 
Open dialog may not show the file. Hold down the shift key while 
selecting the Import Study Tools menu item to show all files.

3. Click Open.
Otobase automatically imports and decrypts the group Checklist, Search and Export 
definitions.

4. You can verify the study tools have been imported by making sure the text on all 
three of the buttons under Checklist/Grouped Export on the form has turned to 
italics.

5. Save the Clinical Group record.
6. Assign Checklists to any Providers who will be entering data in the study (see 

“Assigning Checklists” on page 30).
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Exporting a Grouped Export
For the purposes of sharing data in a clinical study, you can create a group of related records 
or subsets of their data fields pertaining to the study, and then export this data. This simplifies 
exporting for users in a clinical study and helps to ensure that data exported for the study is 
valid and complete. You or your study coordinator define the data fields that make up a 
Grouped Export using the Preferences form and then assign the Grouped Export to a Clini-
cal Group (see “Creating a Clinical Group Export” on page 27 and “Assigning a Clinical 
Group Search and Export” on page 29).

Selecting the Export a Grouped Export item on the Administrator Menu Bar opens the form 
called Clinical Groups with Defined Exports.

The form displays a list of all Clinical Groups with defined exports. If you double-click on 
one of the groups, Otobase will execute the predefined searches for the records to be 
exported. In addition to selecting the appropriate Clinical Group for export, you can choose 
to export just the checksums without the actual data.

If you select the checksums option, Otobase will export the checksums in a TRANSFER-
type document, which can be encrypted.

Selecting the Records option will add the records that make up a Grouped 
Export to a set of previously exported records. If you try to export the same 
records, you will see an Alert dialog reminding you that the records have 
already been exported. To export these records again, open the appropriate-
Clinical Group form and select the Clinical Group > Erase Grouped Export Set menu item.

If the Clinical Group was designated as a study and if an encryption key pair has been 
assigned to the study, the export files will be encrypted automatically. In addition, if a study 
participant ID was assigned, it will be substituted in all ID fields (see “Assigning Study Partic-
ipant IDs” on page 22).

Tips on using e-mail to export and import shared study data
When exporting a Grouped Export, you will be given the option of saving the grouped export 
documents as disk files or sending them via e-mail using the Clinical Group’s e-mail address and 
attachment information. If the export documents are sent via e-mail, they will also be saved in a 
folder whose name is the date of the mailing (for example, “2_21_2002”). This folder will be 
found in the OTBEC folder, saved in various locations depending on your operating system. To 
find the path to the OTBEC folder, click Help > About Otobase (Windows) or Apple Menu > About 
Otobase (Mac) and select the Folder Info tab.

Otobase-generated e-mail can be identified by the e-mail subject line, which follows the format: 
“$OT2Doc_001UWMC...” You can copy any attached documents to disk using your e-mail pro-
gram and import them from there, or Otobase can download the e-mail attachments directly.

To use e-mail importation, make sure your e-mail information is entered on your Provider form, or 
in the case of the Administrator, entered via the Administrator e-mail item on the Provider form. 
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